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Instruction 

Building the Android Application Development Environment 

 

1. Development Environment 

Table 1 shows the development environment on this instruction.  

Table 1. Development Environment 

OS Windows7 (32bit or 64bit) 

Working Directory C:¥Android_Work 

Java Java SE JDK latest version (8u20) 

Development Environment Eclipse ADT latest version (20140702) 

Target Android API Version Android 4.4.2 

Google API Google Maps Android API v2 

 

The procedure of the structure is: 

2: Install the Android SDK and Eclipse 

3: Install the required software for the Java Development Kit（JDK） 

4: Import the sample program 

5: Build the Android emulator– Software Configuration 

           The software (32bit ver. And 64bit ver.) will be provided by CD-R 

＜Note＞ 

The working directory “C:¥Android_Work” must be constructed beforehand. 

 

2. Install the Android SDK and the Eclipse 

2.1 Open the URL in a browser 

        http://developer.android.com/sdk/index.htm 

  

http://developer.android.com/sdk/index.htm
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2.2 Click “Download Eclipse ADT with the Android SDK for Windows”  

 

 

2.3 Mark required items and click “Download Eclipse ADT with Android SDK for Windows”. 
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2.4 Save and extract the zip file after the download. 

Select a destination to “C:¥Android_Work¥”（**1） 

 

      （**1：Be aware of the error due to the limitation of the path length when extracting 

the zip file.） 
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3. Install the Java Development Kit（JDK） 

3.1 Open the URL in a browser 

http://www.oracle.com/technetwork/java/javase/downloads/index.html 

 

3.2 Click “DOWNLOAD” of the latest version of JDK (8u20 on this instruction manual)  

 

 

3.3  Check “Accept License Agreement” and download “Windows x86” by clicking the file 

name on the right（In case of 64 bit OS, download the “Windows x64” ）

 

 

http://www.oracle.com/technetwork/java/javase/downloads/index.html
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3.4 For the installation, run the executable zip file. Use the default settings on the 

installation process. 
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4. Import the sample program 

4.1 Run “C:¥Android_Work¥adt-bundle-windows-x86-20140702¥eclipse¥eclipse.exe” 

and start the Eclipse 

 

 

4.2 Set the workspace for “C:¥Android_Work¥workspace” and click the OK button. 

 

 

4.3 Open the File Menu and select “Import” 

 

4.4 Select “Existing Android Code Into Workspace” and click the Next button. 
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4.5 Set the folder path and mark the listing 3 project. 

And check the “Copy projects into workspace” then click the Finish button. 

Set the folder path of sample source to “Root Directory”, and then 3 projects appear. 

Check all of 3 projects and “Copy projects into workspace” and click the Finish button. 

 

4.6 Confirm the 3 items are added on the “Package Explorer” on the left hand of the screen and 

no error has occurred at the “Problems” views on the bottom of the screen. 

 

 



 8 

5 Building an Android emulator 

5.1 Select Android SDK Manager from the Window menu. 

 

 

5.2 From the list, check the 3 items below and click “Install 3 packages…”.  

Be sure not to check other items to save the installation time. 

・Android 4.4.2 (API 19) - Google APIs (x86 System Image) 

・Android 4.4.2(API 19) – Google APIs (ARM System Image) 

・extra – Intel x86 Emulator Accelerator (HAXM installer) 
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Fig 5.2) Install Package Files 

 

5.3 Check “Accept License” radio button and start the download & install. 

 

 

5.4 After finishing installation, then close the Android SDK Manager window.  

 

5.5 On the Eclipse, click Window -> [Android Virtual Device Manager] (ADV) 
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5.6 From AVD Manager Window, select the “Device Definitions” tab and choose 

“Garaxy Nexus” and click “Create AVD” from the list. 

 

5.7 Set the each items on appeared dialog as indicated on the table 5.7 and click OK. 

Leave the default settings for the items which are not listed on the table 5.7. 

 

Table 5.7) Settings for creating the AVD 

Target Google APIs (x86 System Image) (Google Inc.) – API 

Level 19 

CPU/ABI Intel Atom (x86) 

Skin HVGA 

Keyboard Checked 

Memory Options (RAM) 768 

Memory Options (VM Heap) 256 

SD Card 2 GiB 

Use Host GPU Checked 
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5.8 Install the Intel HAX 

Execute ”IntelHaxm.exe” from the path below and install  

<Installed DIR>¥sdk¥extras¥intel¥Hardware_Acceleted_Execution_manager¥ 

 

5.9 After restarting the Android Virtual Device (AVD) Manager window,  

click “start” and confirm the emulator activates properly.
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6 Execution Environment of the system 

6.1 This system is executed by the application on the Android devices and the 

Web(PHP) ＋ Database(MySQL) server constructed on the web site. 

The connection between the application and web server uses HTTP connection.  

 

6.2 Using e-mail address for the user identifications. E-mail address will be registered 

on the set-up the applications and can be changed later on. And the user password 

must be controlled together. 

 

6.3 This system runs on the Android devices requires internet access (WiFi, LTE and 

etc. ). 

 

 

 

 

 

 

 

 

 

                     Table 6.3)  Server SPECs 

OS CentOS ver6.5 (64bit) 

IP addresses 

 Bit Datacenter 内 

Global IP: 114.179.41.91 

 Port No: 80, 443, 22 

Local IP: 192.168.200.150 

System XAMPP for Linux ver 1.8.3 

Database MySQL ver5.6.20 

phpMyAdmin ver 4.2.7.1 

Web Server Apache ver 2.4.10 

Server side script PHP ver 5.5.15 & PEAR 

 

 

 

Apache 

Web 

Server 

MySQL 

DB 

Application 

Internet 
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7. Create and use the client ID for Google Maps Android API v2 

 If you can open the Google map correctly on your AVD, you don’t need to do as 

follows.  

 

7.1 Access the Google Developer console web site and login. 

（https://console.developers.google.com/） 

・User: mext2014001@gmail.com 

・Pass: Bit2014@mextproject 

 

 

 

7.2 Click “My Project” link. 

 

 

  

https://console.developers.google.com/
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7.3 Click “APIs & auth” -> ”Credentials”. 

 

 

7.4 Click “Create a new key” button.  

7.5 And click “ Android key” button. 
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7.6 Start command prompt on your windows PC and type the below command 

for creating the fingerprint of your PC’s certification.  

 

cd "c:¥Program Files¥Java¥jdk1.8.0_20¥bin" 

keytool -list -v -keystore c:¥Users¥”Your name’s folder”  

                                   ¥.android¥debug.keystore 

**When the entering password screen is displayed, you just press enter 

key. 

 

7.7 Copy the fingerprint that is next to “SHA1:” to the clipboard.  
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7.8 Paste the fingerprint on the field that on the Google web site and go on to 

type “;com.example.MapApplication”. Then click “Create” button to make 

an API KEY.   

 

 

7.9 Make a note of API KEY. 
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7.10 Open “MapApplication/AndroidManifest.xml” on the Package Explorer. 

And replace the variable of “android:value” to your API KEY. 

 

 

 

 

 

END 
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アンドロイド開発環境構築手順書 

1 開発環境 

本手順書で構築する開発環境は表 1の通りである。 

表 1 開発環境 

OS Windows7 (32bit or 64bit) 

作業ディレクトリ C:¥Android_Work 

Java Java SE JDK 最新版 (8u20) 

開発環境 Eclipse ADT 最新版 (20140702) 

Target Android API Version Android 4.4.2 

Google API Google Maps Android API v2 

 

 開発環境の構築手順としては、「2.Android SDK、Eclipseのインストール」「3. Java 

Development Kit（JDK）のインストール」で必要なソフトウェアをインストールし、

「4.サンプルプログラムのインポート」、「5. Androidエミュレータの作成」でソフト

ウェアの設定を行う。またインストールするソフトウェア(32bit 版及び、64bit 版)は、

CD-Rにて提供する。 

＜注意＞ 

・作業ディレクトリ「C:¥Android_Work」はあらかじめ作成しておくこと。 

 

 

 

 

2 Android SDK、Eclipseのインストール 

2.1 下記の URLをブラウザで開く。 

        http://developer.android.com/sdk/index.htm
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2.2 「Download Eclipse ADT with the Android SDK for Windows」をクリック

する。 

 

 

2.3 必要な項目にチェックをして「Download Eclipse ADT with the Android 

SDK for Windows」をクリックする。 
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2.4 zipファイルのダウンロードが開始されるので保存し、解凍を行う。展開先フ

ォルダは「C:¥Android_Work¥」とする（※1）。 

 

   （※1：zipファイル名が付いたまま解凍すると、ファイルパスが長くなりすぎ

てエラーが発生するため注意すること） 
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3 Java Development Kit（JDK）のインストール 

3.1 下記の URLを開く。 

http://www.oracle.com/technetwork/java/javase/downloads/index.html 

 

3.2 作業時の最新バージョン（本手順書では 8u20）での、JDKの「DOWNLOAD」

をクリックする。 

 

 

3.3 「Accept License Agreement」をチェックし、「Windows x86」右のファイ

ル名をクリックしてダウンロードを開始する。（OSが 64bitの場合、

「Windows x64」からダウンロードする） 

 

http://www.oracle.com/technetwork/java/javase/downloads/index.html
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3.4 ダウンロードしたファイルを実行しインストールを行う。途中の設定項目は

全てそのままでよい。 
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4 サンプルプログラムのインポート 

4.1 「C:¥Android_Work¥adt-bundle-windows-x86-20140702¥eclipse¥eclipse

.exe」を実行し、Eclipseを起動する。 

 

 

4.2 Workspaceを「C:¥Android_Work¥workspace」に設定し、OKをクリック

する。 

 

4.3 メニューから[File->Import]をクリックする。 
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4.4 「Existing Android Code Into Workspace」を選択し、Nextをクリックする。 

 

4.5 「Root Directory」にサンプルソースを設置したフォルダパスを設定すると 3

つのプロジェクトが表示されるので全てにチェックを入れ、「Copy projects 

into workspace」にもチェックを入れてから Finishをクリックする。 

 

4.6 画面左の「Package Explorer」に 3項目追加されており、また画面下の

「Problems」ビューでエラーが発生していないことを確認する。 
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5 Androidエミュレータの作成 

5.1 Eclipseのメニューから[Window -> Android SDK Manager]をクリックする。 

 

 

5.2 開いたウィンドウの一覧から下記の 3つにチェックをして「Install 3 

packages…」をクリックする。時間が掛かるため、他にチェックが入ってい

た場合は消しておく。 

・Android 4.4.2 (API 19) - Google APIs (x86 System Image) 

・Android 4.4.2(API 19) – Google APIs (ARM System Image) 

・extra – Intel x86 Emulator Accelerator (HAXM installer) 
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図 5.2  インストール対象パッケージ 

 

5.3 ダイアログの「Accept License」にチェックを入れ、「Install」をクリック

するとダウンロードとインストールが開始される。 

 

 

5.4 Statusが「Installed」となればインストール完了のため、Android SDK 

Managerウィンドウを閉じる。 

 

5.5 Eclipseのメニューから[Window -> Android Virtual Device Manager] 

(ADV)をクリックする。 
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5.6 開いたウィンドウの「Device Definitions」タブを開き、一覧から「Galaxy 

Nexus」を選択してから[Create AVD]をクリックする。 

 

5.7 開いたダイアログで表 5.7の通りに設定し、OKをクリックする。表 5.7に書

かれていない設定項目はそのままでよい。 

 

表 5.7 作成する AVDの設定内容 

Target Google APIs (x86 System Image) (Google Inc.) 

– API Level 19 

CPU/ABI Intel Atom (x86) 

Skin HVGA 

Keyboard Checked 

Memory Options (RAM) 768 

Memory Options (VM Heap) 256 

SD Card 2 GiB 

Use Host GPU Checked 
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5.8 Intel HAXのインストール 

下記のパスにある”IntelHaxm.exe”を実行してインストールを行う。 

         <導入先パス>¥sdk¥extras¥intel¥Hardware_Acceleted_Execution_manager¥ 

 

5.9 Android Virtual Device (AVD) Managerウィンドウに戻るので、「Start」

をクリックしてエミュレータが正常に起動することを確認する。 
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5.10 サンプルプログラムを実行する場合は、eclipse画面左の「Package Explorer」

の「MapApplication」を右クリックし、「Run -> Android Application」を

選択する。 
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6 システムの実行環境について 

6.1 このシステムは、アンドロイド端末上のアプリケーションと、インターネッ

ト上に構築されたWeb(PHP) ＋ Database(MySQL)サーバによって実行さ

れる。アプリケーションとWebサーバ間は、HTTP通信が使用される。 

 

6.2 利用者の識別にメールアドレスを使用する。メールアドレスは当アプリケー

ションの初期起動時に登録し、後で変更することも出来る。またパスワード

もメールアドレスと一緒に管理する。 

 

6.3 当システムを利用するアンドロイド端末は、常にインターネットに接続出来

る環境(Wi-Fiや LTE等)でアプリケーションを実行する事を前提とする。 

 

 

 

 

 

 

 

 

 

 

表 6.3 サーバ環境一覧 

OS CentOS ver6.5 (64bit) 

IP addresses 

 Bit Datacenter内 

Global IP: 114.179.41.91 

 Port No: 80, 443, 22 

Local IP: 192.168.200.150 

System XAMPP for Linux ver 1.8.3 

Database MySQL ver5.6.20 

phpMyAdmin ver 4.2.7.1 

Web Server Apache ver 2.4.10 

Server side script PHP ver 5.5.15 & PEAR 

 

  

Apache 

Web 

Server 

MySQL 

DB 

Application 

internet 
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7. Google Maps Android API v2キーの取得 

 通常本手順は実施しなくてもよい。アプリケーションが正常に動作しているにも関わ

らず地図が表示されない場合に実施する。 

 

7.1 Google Developer console（https://console.developers.google.com/） 

を開き、下記アカウントでログインする。 

・User: mext2014001@gmail.com 

・Pass: Bit2014@mextproject 

 

 

 

7.2 「My Project」をクリックする。 

 

 

  

https://console.developers.google.com/
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7.3 画面左の「APIs & auth」を開き、「Credentials」をクリックする。 

 

 

7.4 「Create a new key」をクリックする。 

7.5 「Android key」を選択する。 
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7.6 証明書のフィンガプリントを作成するため、スタートメニューからコマンド

プロンプトを起動し、下記のコマンドを実行する。 

 

cd "c:¥Program Files¥Java¥jdk1.8.0_20¥bin" 

keytool -list -v -keystore %USERPROFILE%¥.android¥debug.keystore 

※実行後、パスワードを求められるが、改行キーのみを押す。 

 

7.7 コマンドを実行し出力された内容の「証明書のフィンガプリント：」以下か

ら、「SHA1:」から始まる英数字列をコピーする。 
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7.8 コピーした内容を 7.5で表示された画面中のテキストボックスに貼り付け、

続けて「;com.example.MapApplication」と入力し「Create」をクリックす

る。 

 

 

 

7.9 API KEY が表示されるため、コピーする。 
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7.10 再度 AVD を起動し Googleマップが表示されるかを確認する。正しく表示さ

れない場合、Package ExplorerからMapApplication/AndroidManifest.xml

を開き、「android:value="○○○"」の○○○の部分にコピーした API KEY

を貼り付ける。 

 

 

 

 

以 上 
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1.はじめに 

本手順で作成される環境は以下のとおりです。 

Redmine Redmine 2.5 

OS CentOS 6.5 

データベース MySQL 5.1.73 

webサーバ Apache 2.2.15(Railsの実行には Passengerを使用) 

Ruby 2.0.0 

 

最新バージョンの環境構築手順は以下を参照してください。 

http://blog.redmine.jp/tags/インストール・設定/ 

 

システム構成を下図に示します。 

 

2.CentOS の設定 

2.1 SELinux を無効にする 

エディタで /etc/sysconfig/selinux を開き、 SELINUX の値を disabled に編集

してください。

http://www.modrails.com/
http://blog.redmine.jp/tags/インストール・設定/
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編集後、CentOS を再起動して下さい。 

 

再起動後、 getenforce コマンドを実行して SELinux が無効になったことを確認して

ください。 Disabled と表示されれば SELinux は無効になっています。 

 

 

2.2 iptables で HTTP を許可 

CentOS 6.4 の初期状態では iptables(ファイアウォール)が有効になっており、外部か

らサーバ上の 80/tcp ポート(HTTP)に接続することができません。クライアントの web

ブラウザからアクセスできるよう iptables の設定を変更します。 

エディタで /etc/sysconfig/iptables を開き、80/tcp への接続を許可するための

以下の記述を追加してください。追加位置は、22/tcp への許可している記述の直後と

してください。 

 

 

 

 

 

 

 

 

SELINUX=enforcing 

↓ 

SELINUX=disabled 

 

reboot 

 

# getenforce 

Disabled 

 

# Firewall configuration written by system-config-firewall 

# Manual customization of this file is not recommended. 

*filter 

:INPUT ACCEPT [0:0] 

:FORWARD ACCEPT [0:0] 

:OUTPUT ACCEPT [0:0] 

-A INPUT -m state --state ESTABLISHED,RELATED -j ACCEPT 

-A INPUT -p icmp -j ACCEPT 

-A INPUT -i lo -j ACCEPT 

-A INPUT -m state --state NEW -m tcp -p tcp --dport 22 -j ACCEPT 

-A INPUT -m state --state NEW -m tcp -p tcp --dport 80 -j ACCEPT 

-A INPUT -j REJECT --reject-with icmp-host-prohibited 

-A FORWARD -j REJECT --reject-with icmp-host-prohibited 

COMMIT 
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設定が終わったら iptables を再起動してください。 

 

2.3 必要なパッケージのインストール 

Redmine を使用するにあたり、必要なパッケージのインストールを行います。 

2.3.1 EPEL リポジトリの登録 

Ruby のビルドに必要な libyaml を yum でインストールできるようにするために、

EPEL(エンタープライズ Linux 用の拡張パッケージ)リポジトリを追加します。 

まず、下記のページで最新の epel-release パッケージの URL を確認してくださ

い。 

http://dl.fedoraproject.org/pub/epel/6/x86_64/repoview/epel-release.html 

URL の確認方法は以下の画像を参考にしてください。 

 

service iptables restart 

 

http://fedoraproject.org/wiki/EPEL
http://dl.fedoraproject.org/pub/epel/6/x86_64/repoview/epel-release.html
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その後、以下のように rpm コマンドを実行してください。CentOS の yum リポジトリに

EPEL が追加されます。 

 

 

yum repolist を実行して表示される一覧に「epel」が含まれていれば EPEL リポジト

リが正しく追加されています。 

 

 

 

 

 

 

 

 

 

 

 

 

2.3.2 開発ツール(C コンパイラ等)のインストール 

 

 

2.3.3 Ruby と Passenger のビルドに必要なヘッダファイルなどのインストール 

 

 

rpm -Uvh epel-releaseパッケージの URL 

yum repolist 

Loaded plugins: fastestmirror 

Loading mirror speeds from cached hostfile 

 * base: mirror.fairway.ne.jp 

 * epel: epel.mirror.net.in 

 * extras: mirror.fairway.ne.jp 

 * updates: mirror.fairway.ne.jp 

repo id          repo name                                                status 

base             CentOS-6 - Base                                           6,367 

epel             Extra Packages for Enterprise Linux 6 - x86_64           10,541< 

extras           CentOS-6 - Extras                                            14 

updates          CentOS-6 - Updates                                          581 

repolist: 17,503 

 

yum groupinstall "Development Tools" 

 

yum -y install openssl-devel readline-devel zlib-devel curl-devel libyaml-devel 
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2.3.4 MySQL とヘッダファイルのインストール 

 

 

2.3.5 Apache とヘッダファイルのインストール 

 

 

2.3.6 mageMagick とヘッダファイル・日本語フォントのインストール 

 

 

ImageMagick と日本語フォントはガントチャートを PNG 形式の画像にエクスポートする

機能、添付ファイルのサムネイル画像を作成するのに使われます。これらのインスト

ールを行わなくても Redmine の実行は可能です。 

3.Ruby のインストール 

3.1 ソースコードのダウンロード 

Ruby のオフィシャルサイトのダウンロードページから Ruby2.0 の最新のソースコード

をダウンロードしてください。 

http://www.ruby-lang.org/ja/downloads/ 

 

 

 

3.2 Ruby のビルド 

ダウンロードした Ruby の tarball を展開し、Ruby のビルドとインストールを行ってくだ

さい。 

 

 

 

yum -y install mysql-server mysql-devel 

 

yum -y install mysql-server mysql-devel 

 

yum -y install ImageMagick ImageMagick-devel ipa-pgothic-fonts 

 

curl -O http://cache.ruby- 

lang.org/pub/ruby/2.0/ruby-2.0.0-p451.tar.gz 

tar zxvf ruby-2.0.0-p451.tar.gz  

cd ruby-2.0.0-p451 

./configure --disable-install-doc 

make 

make install 

cd .. 

 

http://www.ruby-lang.org/ja/downloads/
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Redmine 2.5 は 2014 年 2 月にリリースされた Ruby 2.1 には対応していません。必ず

Ruby 2.0 をインストールしてください。 

--disable-install-doc を指定すると Ruby のドキュメントのインストールを省略で

き、作業時間を短縮できます。 

インストール後、 ruby -v を実行して Ruby のバージョンを表示させ、インストールが

完了したことを確認してください。 

 

 

3.3 bundler のインストール 

Redmine が使用する Gem を一括インストールするためのツール、bundler をインスト

ールします。 

 

 

--no-rdoc --no-ri はドキュメントのインストールを省略するためのオプションで

す。 

ファイル ~/.gemrc に以下の記述を行っておくとコマンドラインで明示的に指定しな

くてもよくなり便利です。 

gem: --no-ri --no-rdoc 

 

4.MySQL の設定 

4.1 デフォルトキャラクタセットを utf8 に設定 

エディタで /etc/my.cnf を開き、 [mysqld] セクションに character-set-

server=utf8 を、 [mysql] セクションに default-character-set=utf8 を追加し

てください。 

ruby -v 

ruby 2.0.0p451 (2014-02-24 revision 45167) [x86_64-linux] 

 

gem install bundler --no-rdoc --no-ri 
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4.2 MySQL の起動および自動起動の設定 

 

 

 

4.3 /etc/my.cnf への設定が反映されていることの確認 

MySQL のシステム変数 character_set_* のうち、 character_set_filesystem 

と character_sets_dir 以外の値がすべて utf8 になっていることを確認してくださ

い。 

latin1 になっている項目があれば、 /etc/my.cnf の設定が正しいか確かめてくだ

さい。 

[mysqld] 

datadir=/var/lib/mysql 

socket=/var/lib/mysql/mysql.sock 

user=mysql 

# Disabling symbolic-links is recommended to prevent assorted security risks 

symbolic-links=0 

 

character-set-server=utf8 

 

# 任意設定 

innodb_file_per_table 

query-cache-size=16M 

 

[mysqld_safe] 

log-error=/var/log/mysqld.log 

pid-file=/var/run/mysqld/mysqld.pid 

 

[mysql] 

default-character-set=utf8 

 

service mysqld start 

chkconfig mysqld on 
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4.4 root ユーザーのパスワード変更・匿名ユーザー削除ほかセキュリティ向上 

MySQL のセキュリティ向上のために、初期設定ツール 

mysql_secure_installation を実行して root パスワードの設定や不要なユーザ

ー・データベースの削除を行います。 

 

 

 

 

 

# mysql -uroot 

mysql> show variables like 'character_set%'; 

+--------------------------+----------------------------+ 

| Variable_name            | Value                      | 

+--------------------------+----------------------------+ 

| character_set_client     | utf8                       | 

| character_set_connection | utf8                       | 

| character_set_database   | utf8                       | 

| character_set_filesystem | binary                     | 

| character_set_results    | utf8                       | 

| character_set_server     | utf8                       | 

| character_set_system     | utf8                       | 

| character_sets_dir       | /usr/share/mysql/charsets/ | 

+--------------------------+----------------------------+ 

8 rows in set (0.00 sec) 

 

mysql> exit 
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mysql_secure_installation 

      : 

    (中略) 

      : 

Enter current password for root (enter for none):   (そのまま Enter キーを押す) 

OK, successfully used password, moving on... 

 

Setting the root password ensures that nobody can log into the MySQL 

root user without the proper authorisation. 

 

Set root password? [Y/n] y 

New password:   (MySQL の root ユーザーに新たに設定するパスワードを入力) 

Re-enter new password:   (新パスワードを再入力) 

Password updated successfully! 

Reloading privilege tables.. 

 ... Success! 

      : 

    (中略) 

      : 

Remove anonymous users? [Y/n] y  (匿名ユーザーを削除) 

 ... Success! 

      : 

    (中略) 

      : 

Disallow root login remotely? [Y/n] y  (root ユーザーの接続元を localhost に限定) 

 ... Success! 

      : 

    (中略) 

      : 

Remove test database and access to it? [Y/n] y  (test データベースを削除) 

 - Dropping test database... 

 ... Success! 

 - Removing privileges on test database... 

 ... Success! 

      : 

    (中略) 

      : 

Reload privilege tables now? [Y/n] y  (これまでの変更を直ちに適用) 

 ... Success! 
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MySQL の root ユーザーに設定した新パスワードは、今後 MySQL に root で接続し

てデータベースの管理操作を行うときに入力を求められます。 

4.5 Redmine 用データベースとユーザーの作成 

 

 

 

 

 

 

※ ******** の部分は任意のパスワードを設定してください。このパスワードは後述

の database.yml の設定で使用します。 

5.Redmine のインストール 

5.1 Redmine のダウンロード 

下記のページから Redmine 2.5 の tarball(.tar.gz)をダウンロードしてください。 

http://www.redmine.org/projects/redmine/wiki/Download 

 

 

tarballをダウンロードするのではなく次のように Subversionリポジトリからソース

コードを取得することもできます。 

svn co http://svn.redmine.org/redmine/branches/2.5-stable 

/var/lib/redmine 

mysql -uroot -p 

mysql> create database db_redmine default character set utf8; 

mysql> grant all on db_redmine.* to user_redmine@localhost identified by 

'********'; 

mysql> flush privileges; 

mysql> exit; 

 

curl -O http://www.redmine.org/releases/redmine-2.5.0.tar.gz 

 

http://www.redmine.org/projects/redmine/wiki/Download
http://www.redmine.org/releases/redmine-2.5.0.tar.gz
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5.2 Redmine の展開と配置 

ダウンロードした Redmine の tarball を展開してください。 redmine-2.5.0 というディ

レクトリが作成され、その下に Redmine を構成するファイル群が作成されます。 

 

Redmine の配置先のディレクトリを決定し、そこへ展開したファイルを移動してくださ

い。例えば、 /var/lib/redmine を配置先とする場合、以下のようにします。 

 

 

5.3 データベースへの接続設定 

Redmine からデータベースへ接続するための設定を記述したファイルを作成します。 

以下の内容で Redmine のインストールディレクトリ(例: /var/lib/redmine)以下に 

config/database.yml を作成してください。 

 

 

 

 

 

※ ******** 部分は、MySQL 上に作成した Redmine ユーザーのパスワードです。 

※ config/database.yml.example に設定例がありますので参考にしてください。 

tar xvf redmine-2.5.0.tar.gz 

 

mv redmine-2.5.0 /var/lib/redmine 

 

 

production: 

  adapter: mysql2 

  database: db_redmine 

  host: localhost 

  username: user_redmine 

  password: ******** 

  encoding: utf8 
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5.4 設定ファイル config/configuration.yml の作成 

Redmine からメールサーバへ接続するための設定や日本語フォントファイルのパスを

記述した設定ファイルを作成します。 

以下の内容で Redmine のインストールディレクトリ以下に 

config/configuration.yml ファイルを作成してください。 

 

 

 

 

 

 

 

 

 

※ example.com の部分は、Redmine を実行するサーバの FQDN としてください。 

※ config/configuration.yml.example に設定例がありますので参考にしてくださ

い。 

configuration.yml ではアップロードされたファイルの保管場所や、データベースの

暗号化なども設定できます。詳しくは http://redmine.jp/config/configuration_yml/ を

ご覧ください。 

production: 

  email_delivery: 

    delivery_method: :smtp 

    smtp_settings: 

      address: "localhost" 

      port: 25 

      domain: 'example.com' 

 

  rmagick_font_path: /usr/share/fonts/ipa-pgothic/ipagp.ttf 

 

http://redmine.jp/config/configuration_yml/
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5.5 Gem パッケージのインストール 

アプリケーションが必要とする Gem を一括してインストールできるツール、bundler を

使用して Redmine で使用する Gem をインストールします。Redmine のインストールデ

ィレクトリで以下のコマンドを実行してください。 

 

 

Redmine 2.3 より、bundler は config/database.yml を参照して適切なデータベース

アダプタをインストールするようになりました。 2.2 までのように --without オプショ

ンで使用しないデータベースアダプタを指定する必要はなくなりました。 

5.6 Redmine の初期設定とデータベースのテーブル作成 

セッションデータ改竄防止用鍵の生成とテーブル作成を行います。Redmine のインス

トールディレクトリで以下のコマンドを実行してください。 

 

 

 

 

5.7 Passenger のインストール 

Apache 上で Redmine などの Rails アプリケーションの実行に必要な Phusion 

Passenger をインストールします。 

 

 

5.8 Passenger の Apache 用モジュールのインストール 

インストーラを実行し画面の指示に従って操作してください。 

bundle install --without development test 

 

 

 

bundle exec rake generate_secret_token 

RAILS_ENV=production bundle exec rake db:migrate 

 

 

gem install passenger --no-rdoc --no-ri 

 

 

http://www.modrails.com/
http://www.modrails.com/
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インストールが完了すると以下のように表示されます。太字の部分は Apache に設定

すべき内容なので控えておきます。表示される設定情報は passenger-install-

apache2-module --snippet を実行して後で参照することもできます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

太字の部分は環境により異なります。上記設定はあくまでも例ですのでそのまま転記

して使用せず、必ずインストール作業中に表示された設定か passenger-install-

apache2-module --snippet により表示されたものを使用してください。 

6.Apache の設定 

6.1 Passenger の設定を追加 

Passenger の設定を Apache に追加します。 /etc/httpd/conf/httpd.conf に直接

追加してもよいですが、管理しやすいよう Passenger 関係の設定は別ファイルにまと

めます。 

passenger-install-apache2-module 

 

 

The Apache 2 module was successfully installed. 

 

Please edit your Apache configuration file, and add these lines: 

 

 

   LoadModule passenger_module /usr/local/lib/ruby/gems/1.9.1/gems/passenger-

3.0.17/ext/apache2/mod_passenger.so 

   PassengerRoot /usr/local/lib/ruby/gems/1.9.1/gems/passenger-3.0.17 

   PassengerRuby /usr/local/bin/ruby 

 

 

After you restart Apache, you are ready to deploy any number of Ruby on Rails 

applications on Apache, without any further Ruby on Rails-specific 

configuration! 

 

Press ENTER to continue. 
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以下の内容で /etc/httpd/conf.d/passenger.conf を作成してください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.2 Apache の起動および自動起動の設定 

 

 

 

# Passenger の基本設定。 

# passenger-install-apache2-module --snippet を実行して表示される設定を使用。 

# 環境によって設定値が異なりますので以下の 3 行はそのまま転記しないでください。 

# 

LoadModule passenger_module /usr/local/lib/ruby/gems/1.9.1/gems/passenger-

3.0.17/ext/apache2/mod_passenger.so 

PassengerRoot /usr/local/lib/ruby/gems/1.9.1/gems/passenger-3.0.17 

PassengerRuby /usr/local/bin/ruby 

 

# Passenger が追加する HTTP ヘッダを削除するための設定（任意）。 

# 

Header always unset "X-Powered-By" 

Header always unset "X-Rack-Cache" 

Header always unset "X-Content-Digest" 

Header always unset "X-Runtime" 

 

# 必要に応じて Passenger のチューニングのための設定を追加（任意）。 

# 詳しくは Phusion Passenger users 

guide(http://www.modrails.com/documentation/Users%20guide%20Apache.html)をご覧く

ださい。 

PassengerMaxPoolSize 20 

PassengerMaxInstancesPerApp 4 

PassengerPoolIdleTime 3600 

PassengerHighPerformance on 

PassengerStatThrottleRate 10 

PassengerSpawnMethod smart 

RailsAppSpawnerIdleTime 86400 

PassengerMaxPreloaderIdleTime 0 

 

 

service httpd start 

chkconfig httpd on 
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6.3 Apache 上の Passenger で Redmine を実行するための設定 

Redmine を配置したディレクトリ以下のファイルを、Apache を実行するユーザー・グル

ープ(CentOS の場合はいずれも"apache")で読み書きできるよう、オーナーを変更し

ます。 

 

 

どのような形態(URL)で Redmine を利用するかによって設定が異なります。三つのパ

ターンを例に挙げます。 

パターン 1: web サーバを Redmine 専用として使用 

web サーバのルートディレクトリで Redmine を実行するための設定です。「http://サ

ーバ IP アドレスまたはホスト名/」で Redmine にアクセスできます。 

エディタで /etc/httpd/conf/httpd.conf を開き DocumentRoot を Redmine の

public ディレクトリ(例: /var/lib/redmine/public )に変更してください。 

 

 

 

設定変更後、Apache を再起動してください。 

 

 

パターン 2: サブディレクトリで Redmine を実行 

URL のサブディレクトリで URL にアクセスできるように設定します。同じサーバで

Redmine 以外のアプリケーションを実行する場合や、複数の Redmine を実行する場

合に便利な設定です。 

chown -R apache:apache /var/lib/redmine 

 

 

DocumentRoot "/var/www/html" 

↓ 

DocumentRoot "/var/lib/redmine/public" 

/etc/init.d/httpd configtest 

/etc/init.d/httpd graceful 
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シンボリックリンクの作成 

Apache の DocumentRoot に指定されているディレクトリ(通常は /var/www/html )

に、Redmine の public ディレクトリ(例: /var/lib/redmine/public)に対するシンボリ

ックリンクを作成します。シンボリックリンクの名称は、URL のディレクトリ名部分で使

いたい名前(例:redmine)にしてください。 

 

 

Apache への設定追加 

Apache の設定ファイル(/etc/httpd/conf/httpd.conf)もしくは前述の手順で作成し

た Passenger の設定ファイル(/etc/httpd/conf.d/passenger.conf)などに以下の

設定を追加します。 

 

 

設定後、Apache を再起動してください。 

 

 

パターン 3: バーチャルホストで Redmine を実行 

特定のバーチャルホストで Redmine を実行する設定です。Apache に以下の設定を

追加します。 

 

 

 

 

ln -s /var/lib/redmine/public /var/www/html/redmine 

 

RackBaseURI /redmine 

 

service httpd configtest 

service httpd graceful 

 

NameVirtualHost *:80 

... 

<VirtualHost *:80> 

    ServerName www.example.jp 

    DocumentRoot /var/lib/redmine/public 

</VirtualHost> 
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設定後、Apache を再起動してください。 

 

 

6.4 インストール完了後の初期設定 

インストールが完了し web ブラウザ経由で Redmine にアクセスできる状態になった

ら、日本語環境で使うための設定変更やユーザーの追加・プロジェクトの追加などを

行います。 

 

/etc/init.d/httpd configtest 

/etc/init.d/httpd graceful 
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1 adminアカウントでのログインとアカウント設定 

1.1 Redmineへログイン 

インストール直後の Redmine には管理者しかいないので管理者でログインします。

Redmine にアクセスしてください。認証が必要と Redmine に設定されている場合はログ

イン画面が既に表示されます。ログイン画面が表示されていない場合は右上の「ログイ

ン」をクリックしてください。 

ログインフォームに「ログイン」「パスワード」を入力してログインしてください。 

Redmine をインストールした直後であればユーザー名、パスワードともに"admin"でロ

グインできます。 

 

1.2 adminユーザのパスワードの変更 

admin ユーザのパスワードがデフォルトのままだと誰でも管理ユーザとして Redmine

にログインできてしまうので変更します。 

個人設定画面の右上の「パスワード変更」をクリックしてください。 
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下記画像の入力箇所(3箇所)すべて入力して「適用」をクリックすると変更が完了し

ます。 

 

入力する内容 

項目 内容 

パスワード 現在使用中のパスワード。 

新しいパスワード 変更しようとしている新しいパスワード。 

パスワードの確認 新しいパスワードフォームに入力したパスワードと同じパスワード。 
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2 管理画面での Redmineの設定 

ロール、トラッカー、チケットのステータス等の初期データを読み込みます。 

2.1 デフォルトデータのロード 

インストールの際に 

 

を行っていない場合はロール、トラッカー、チケットのステータス、ワークフローが

登録されておらず Redmine の多くの機能が利用できないので、デフォルトデータを

Redmine に読み込みます。 

インストール時に上記コマンドを実行済みであれば本手順は不要です。 

・管理画面からのデフォルトデータのロード手順 

画面左上の「管理」をクリックしてください。 

 

管理画面中央付近にデフォルト設定のロードを促す表示があります。そこでトラッカーや

ロールの名称で使用する言語（通常は「Japanese (日本語)」）を選択し、「デフォルト設定

をロード」ボタンをクリックしてください。 

rake redmine:load_default_data RAILS_ENV="production" 
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「デフォルト設定をロードしました。」と表示されれば完了です。 

 

 

2.2 日本語での利用に適した設定 

「既定の言語」や「ユーザ名の表示書式」の設定を行います。 

Redmine を日本語環境で使いやすいようにする設定です。 

 

以下の設定を行います。 

•「既定の言語」を「日本語 (Japanese)」に設定 

•「名前の書式」を姓が先に来るよう設定 

 

・設定手順 

画面左上の「管理」をクリックしてください。 

 

 

管理画面の「設定」をクリックしてください。設定ページが表示されます。 
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「表示」タブを開き、以下のように設定を行ってください。
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2.3 メールに含まれる Redmineのアドレスを正しく設定する 

Redmine はチケットの登録・更新などの通知メールにチケットへのリンク URL を含め

て送信しますが、インストール直後の Redmine で設定されている 

http://localhost:3000/ という URL は多くの環境では正しくないので変更します。 

 

正しい URL が生成されるように設定することにより、メール内のリンクをクリックし

て Redmine のチケットを素早く表示させることができるようになります。 

 

・設定方法 

画面左上の「管理」をクリックしてください。 

 

 

管理画面の「設定」をクリックしてください。設定ページが表示されます。 

 



 

7 

 

「表示」タブを開き、以下のように設定を行ってください。 

 

・ホスト名の設定 

ホスト名とは Redmine にアクセスするための URL から http://や https://を除いた部

分です。サブディレクトリに Redmine が導入されている場合はディレクトリ名も含み

ます。 

入力欄の下に例として Redmine が自動的に割り出したものが表示されていますので、

通常はそれをそのまま入力してください。 

 

 



 

8 

 

 

 

・プロトコルの設定 

通常は HTTP、SSL で Redmine にアクセスする場合は HTTPS を選択してください。 

※SSL を利用するためには web サーバで SSL サーバ証明書の組み込み等の作業が別途

必要です。 

 

 

3 プロジェクト管理のための準備 

3.1 プロジェクトの追加 

Redmine にプロジェクトを追加します。 

 

・プロジェクトの追加手順 

画面左上の「管理」をクリックし、管理の中の「プロジェクト」をクリックしてくだ

さい。プロジェクト画面が表示されます。 
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プロジェクト画面右上の「新しいプロジェクト」をクリックしてください。「新しい

プロジェクト」画面が表示されます。 

 

 

「新しいプロジェクト」画面で新たに追加するプロジェクトの情報を入力してくださ

い。入力項目のうち「名称」と「識別子」以外は省略できます。 

項目 内容 

名称 
プロジェクトの名称です。プロジェクトセレクタなど Redmine の各画面に表示

されます。 
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説明 
プロジェクトについての簡単な説明です。各プロジェクトの概要画面に表示さ

れます。 

識別子 プロジェクトの識別子です。URL の一部などに使用されます。 

公開 

チェックを ON にすると公開プロジェクトとなります。デフォルトでは ON で

す。プロジェクトのメンバーとして登録されていないユーザも情報を閲覧でき

ます 

 

項目の入力が終わったら「保存」をクリックしてください。プロジェクトが作成されま

す。 

 

3.2 ユーザの追加 

Redmine にログインできるユーザを追加します。 

 

画面左上の「管理」をクリックしてください。 
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管理画面が表示されます。管理の中の「ユーザー」をクリックしてください。 

 
ユーザー画面の右上にある「新しいユーザー」をクリックしてください。 
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新しいユーザー画面に新しいユーザーについての下記の情報を入力してください。 

 

・基本情報 

項目 内容 

ログイン 新しいユーザーがログイン時に使用するユーザー名を入力してください。 

名前 新しいユーザーの名を入力してください。 

苗字 新しいユーザーの姓を入力してください。 

メールアドレ

ス 

新しいユーザーに更新通知などが送信されるアドレスを入力してくださ

い。 

管理者 チェックを入れると Redmine の管理者として登録することができます。 

 

・認証 

項目 内容 

パスワード 
新しいユーザーがログインする際に入力するパスワードを入力してくだ

さい。 

パスワードの確

認 

ミスを防ぐためにパスワードに入力したものをもう一度入力してくださ

い。 

 

・メール通知 

ここではメールが通知される条件を選択してください。「自分自身による変更の通知は不要」

にチェックをいれるとユーザー自身で変更、作成などをした場合にメールは送信されませ

ん。 
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・設定 

項目 内容 

メールアドレ

スを隠す 
チェックを入れると他のユーザーにメールアドレスが表示されません。 

タイムゾーン 
新しいユーザーのタイムゾーンを入力してください。空白のままだと

Redmine に設定されたタイムゾーンに設定されます。 

コメントを表

示 

古い順 チケットの更新履歴などが古いものから順に表示されます。 

新しい順 チケットの更新履歴などが新しいものから順に表示されます。 

項目の入力が終わったら「作成」をクリックしてユーザーを作成してください。連続して

ユーザーを作成する場合には「連続作成」をクリックしてください。 

3.3 プロジェクトのメンバーを追加 

ユーザをプロジェクトのメンバーとして追加します。 

 

・ユーザの追加方法 

 

画面左上トップメニュー内の「管理」をクリックし、管理画面内の「プロジェクト」
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をクリックしてください。  

メンバーを追加したいプロジェクトを選択し、設定タブをクリックしてプロジェクト

の設定画面を開いてください。 

 

 

 

プロジェクト設定画面で「メンバー」タブをクリックし、画面右側の「新しいメンバ

ー」から追加するメンバーとロールを選び「追加」をクリックしてください。メンバ

ー、ロールは複数選択することもできます。 
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メンバーが追加されるとプロジェクトの「メンバー」タブに表示され、メンバーになった

ユーザには設定されたロールで定義された権限がそのプロジェクトにおいて付与されま

す。 

 

3.4 ロールと権限 

ロールとは、ユーザーがプロジェクト上で行える操作を定義したものです。Redmine

には「チケットの追加」や「チケットの追加」など約 60 の権限があります。それらの

権限の有無をまとめて定義したものがロールです。 

 

また、チケットのステータスをどのように遷移させることができるのか定義する「ワ

ークフロー」でもロールが参照されます。 

 

ユーザーをプロジェクトの メンバー として登録する際にはそのユーザーをどのロー

ルとするのかも指定します。これにより、そのユーザーがプロジェクトでどのような

操作が行えるのかが決まります。 
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3.4.1 デフォルトのロール 

インストール直後の Redmine には「管理者」、「開発者」、「報告者」 の 3つのロール

が登録されています。 

 

・管理者 

そのプロジェクトにおけるほぼすべての操作が行える。 

・開発者 

メンバーの追加、チケットの書き換えや削除など一部の操作が行えないが、通常の

利用に十分な権限が与えられている。 

・報告者 

テスト担当者を想定したロールで、チケットの登録など限られた操作のみが行え

る。 

 

3.4.2 ロールの追加・変更・削除 

 

ロールに割り当てられた権限の確認や変更、新たなロールの作成は「管理」→「ロー

ルと権限」画面で行います。各ロールの権限を比較したり、複数のロールの権限をま

とめて変更するときは「管理」→「ロールと権限」→「権限レポート」画面が便利で

す。 
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3.5 トラッカー 

トラッカーはチケットの大分類です。また、チケットのステータスを、どのロールの

ユーザーがどのように遷移させることができるのかというワークフローの定義も行い

ます。チケットは必ず一つのトラッカーに所属します。トラッカー無しのチケットは

作成できません。 

 

デフォルトでは次の 3つのトラッカーが登録されています。 

 

バグ  バグ修正等  

機能  新たな機能の開発、既存の機能を改良等  

サポート  
成果物に直接結びつかない(ソースコードの変更が発生しない)作業。例え

ばプロジェクト運営のための資料作成、各種手続きなど  

 

トラッカーの作成・編集・削除は 管理 → トラッカー で行えます。また、トラッカ

ーに対するワークフローの定義は 管理 → ワークフロー で行います。 

 

3.5.1 トラッカーの機能 

 

・チケットの分類 

チケットを分類するために利用できます。 

・ワークフローの定義 

ロールとトラッカーの組み合わせごとに、どのようなステータス遷移を許可するの

か設定できます。 

(「管理」→「ワークフロー」画面の「ステータスの遷移」タブ) 

・フィールドに対する権限の設定 

ロール・トラッカー・ステータスの組み合わせごとに、標準フィールドとカスタム

フィールドを「読み取り専用」「必須」の権限を設定できます。 

(「管理」→「ワークフロー」画面の「フィールドに対する権限」タブ) 

・チケットで使用するフィールドの設定 

トラッカーごとに、標準フィールドとカスタムフィールドの有効・無効（入力項目

として使用するかしないか）を設定できます。 

(「管理」→「トラッカー」画面) 
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本プロジェクトでは、以下のトラッカーを使用します。 

トラッカー 説明 

Request プロダクトバックログのチケットユーザー要望など。このチケットにより要

件が管理され、実現可否・工数・期間などの調整後に Feature に変更

していく。 

Feature スプリントバックログのチケット設計やプログラミング、テストなど 

Issue 開発チームで抱える課題。 

Bug 障害全般。 単体テスト障害、結合テスト障害などの障害 

Support ユーザーからの問い合わせなど。このチケットは Close するか、また

は Issue や Request や Bug に変更していく。 

3.6 ワークフロー 

ワークフローとは、ユーザーがチケットのステータスをどのように変更できるのか

を、 トラッカー と ロール の組み合わせごとに定義したものです。例えばトラッカ

ーが「バグ」のチケットを完了させることができるのは管理者ロールのユーザーに限

定するなど、Redmine を利用する組織にあわせたワークフローを定義できます。 

 

ワークフローはチケットのステータスをどのように遷移させることができるのかを定

義したものなので、ワークフローが定義されていなければチケットのステータスを変

更することができません。 

 

1 個のトラッカーに対して、Redmine 上に存在するロールの数だけワークフローが存在

します。つまり、1 つの Redmine 上には、トラッカー数×ロール数だけのワークフロ

ーが存在します。 

 

ワークフローの参照や設定変更は、 「管理」 → 「ワークフロー」で行えます。 

 

・設定例 

以下は「開発者」ロールの「バグ」トラッカーに対するワークフローのデフォルト

設定です。「開発者」ロールのユーザーが「バグ」トラッカーのチケットのステータ

スを変更する際は以下の制限が課せられます。 

•チケットのステータスを「新規」に変更できない 

•チケットのステータスを「却下」に変更できない 
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•ステータスが「終了」「却下」のチケットはステータスを変更できない 

 

3.7 チケットのステータス 

ステータスはチケットの進捗状況を表すものです。デフォルトでは「新規」「進行中」

「解決」「フィードバック」「終了」の 5個が登録されています。 

 

登録した直後のチケットは 新規 であり、まだ誰も手をつけていないことを示してい

ます。ステータスを更新することで、全体の進捗を管理する立場の人からは Redmine

を見るだけで作業に着手したことが分かります。また、作業を実施する担当者も、チ

ケットの一覧でフィルタを適用すれば自分が担当する 進行中 のチケットが分かるの

で、抱えているタスクを容易に把握できます。タスクを抱えすぎて何をすべきか分か

らない、という状況に陥るのを防ぐのにも役立ちます。 

 

3.7.1 デフォルトのステータスの意味 

・新規 

新たに登録されたもの。作業は未着手。 

・進行中 

担当者が作業に着手。 

・解決 

担当者の作業が終了。 

・テスト／レビュー待ち。 
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フィードバック 

・差し戻し。 

  作業が完了したものについてテストやレビューを行った結果、修正や追加の作業 

必要となったもの。 

・終了 

作業完了。 

・却下 

作業を行わずに終了。 

  採用されなかった新機能の提案、バグとして報告されたが修正する必要のないもの

（報告者の誤認など） 

 

3.7.2 ステータスの追加・変更・削除 

システム管理者が「管理」→「ステータス」画面で追加・変更・削除を行えます。 

 

本プロジェクトは以下のステータスを使用します。 

・ToDo(新規) 

新たに登録されたもの。作業は未着手。 

・Doing(進行中) 

担当者が作業に着手。 

・Solved(解決) 

担当者の作業が終了。 

・Feedback(フィードバック) 

作業が完了したものについてテストやレビューを行った結果、修正や追加の作業 

必要となったもの。 

・Done(終了) 

作業完了。 

 



 

Instruction of the Test server environment on Windows OS 

1 PC environment 

Fig.1 Test server PC environment 

OS Windows7 (32bit or 64bit) 

Software XAMPP 1.8.3（PHP 5.5.15） 

Target directory C:¥xampp¥ 

 

 

2 Download XAMPP software and installation 

2.1 Download XAMPP software from the URL as follows:  

          https://www.apachefriends.org/index.html 

Fig. 2.1 

 

 

 

https://www.apachefriends.org/index.html


 

 

2.2 Execute the downloaded file and start installation. 

Fig. 2.2.1 

 

Fig. 2.2.2 

 

Fig 2.2.3 

 

 

 



 

Fig. 2.2.4 

 

 

・ Select Components： Apache, MySQL and phpMyAdmin  

Fig. 2.2.5 

 

 

 



 

・ Set Installation folder to “C:¥xampp” (Default). 

Fig. 2.2.6 

 

 

・ Uncheck “Learn more about Bitnami for XAMPP”. 

Fig. 2.2.7 

 

 



 

Fig. 2.2.8 

 

Fig. 2.2.9 

 

 

 

 

 



 

2.3 After installation, start the Control Panel.  

Fig 2.3 

 

 

2.4 Start Apache and MySQL services.  

Fig 2.4.1 

 

 

 

 



 

Fig 2.4.2 

 

 

Fig 2.4.3 

 

 

Fig 2.4.4 

 

 



 

Fig 2.4.5 

 

 

 

 

2.5 Access the URL “http://localhost/” using web browser. 

Fig 2.5 

 

 

 

 

http://localhost/


 

2.6 Open Security menu and solve all security issues.  

Fig 2.6.1 

 

 

Fig 2.6.2 

 



 

3 Set up Apache configurations. (for Web server) 

3.1 Open “C:¥xampp¥apache¥conf¥httpd.conf” using notepad.exe. 

3.2 Edit 2 lines of httpd.conf file as follows:  

Original： DocumentRoot "C:/xampp/htdocs" 

<Directory "C:/xampp/htdocs"> 

Change： DocumentRoot "C:/xampp/htdocs/php" 

<Directory "C:/xampp/htdocs/php"> 

 

3.3 Create a new “php” folder under the “C:¥xampp¥htdocs¥” and put all php 

server script files in the folder.  

 

4 Set up MySQL configurations (for database) 

4.1 Open command prompt. 

4.2 Move to the folder that there is “SETUP_DB.sql” DDL script in. 

4.3 Execute the command as follows:  

C:¥xampp¥mysql¥bin¥mysql.exe -u root -p -f < SETUP_DB.sql 

 

Fig 4.3 

 

 

END. 



 

サーバ環境構築手順書 

1 サーバ環境 

本手順書で構築するサーバ環境は表 1の通りである。 

 

表 1 開発環境 

OS Windows7 (32bit or 64bit) 

サーバソフトウェア XAMPP 1.8.3（PHP 5.5.15） 

インストール先 C:¥xampp¥ 

 

 

2 XAMPPのダウンロード、インストール 

2.1 下記の URLをブラウザで開き、構築するサーバ OSの XAMPPをダウンロ

ードする。 

https://www.apachefriends.org/jp/index.html 

 

 

https://www.apachefriends.org/jp/index.html


 

 

2.2 ダウンロードしたファイルを実行し、インストーラの指示に従ってインスト

ールを行う。Windowsの場合、実行ファイルを右クリックし「管理者として

実行」で実行すること。 

設定は下記の通りに行う。 

・Select Components：全てチェック有（デフォルト） 

・Installation folder：「C:¥xampp」（デフォルト） 

・Bitnami for XAMPP：「Learn more about～」のチェックを外す 

 

 

 



 

 

 

2.3 インストールが完了すると図 2.3が表示されるので、「Do you want to start 

the Control Panel now?」にチェックを入れたまま Finish をクリックする。 

 

図 2.3 



 

 

2.4 XAMPP Control Panelが起動するので、Moduleが「Apache」と「MySQL」

と書かれている右の Startボタンをクリックする。正常に起動すると、図 2.4

のようにModule名の背景が緑色になる。 

  

図 2.4 ApacheとMySQLが正常に起動した状態 

 

2.5 「http://localhost/」にアクセスし、XAMPPのページが表示されることを確

認する。 

2.6 必要に応じて画面左の「セキュリティ」の設定を行う。 

 

http://localhost/


 

 

3 Apache（Webサーバ）の設定 

3.1 「C:¥xampp¥apache¥conf¥httpd.conf」をテキストエディタで開く。 

3.2 テキストの内容を表 3.2の修正前に該当する 2行を修正後の通りに修正する。

表 3.2 httpd.confの修正内容 

修正前： DocumentRoot "C:/xampp/htdocs" 

<Directory "C:/xampp/htdocs"> 

修正後： DocumentRoot "C:/xampp/htdocs/php" 

<Directory "C:/xampp/htdocs/php"> 

 

3.3 「C:/xampp/htdocs」にフォルダ「php」を作成し、サーバスクリプトを作成

したフォルダ内に配置する。 

 

 

4 MySQL（データベース）の設定 

4.1 コマンドプロンプトを起動する。 

4.2 カレントディレクトリにデータベースの設定を行うスクリプトファイル

（SETUP_DB.sql）を移動する。 

4.3 次のコマンドを実行する。実行時にパスワードを要求されるので、2.6で設定

したパスワードを入力する。 

C:¥xampp¥mysql¥bin¥mysql.exe -u root -p -f < SETUP_DB.sql 

         警告が発生する場合があるが、無視してよい。 

 

以 上 



開発補足資料１□Androidエミュレータでの GPS情報送信方法 

 

１．「Window＞Open Perspective＞Other」を選択し、開いたダイアログ中から「DDMS」

を選択する。 

 

 

 

 

 

 

２．画面左部の一覧から GPS情報を送信するエミュレータ端末を選択する。 

３．画面右部の「Emulator Control」を選択し、「Location Controls」下のタブでManual



を選択する。 

 

 

 

４．「Longitude」「Latitude」を入力して Sendボタンをクリックすると、GPS情報がエミ

ュレータに送信される。 

 

例 1）ユーコムの位置 

longitude：137.086027 

latitude：36.723532 

 

例 2）Bitの位置 

longitude：36.725310 

latitude：137.096817 

 



プロジェクト名： XXXXXXXXX
マスタースケジュール グループ名： リーダ名： 更新日： 2015/2/1

以下は例として記入されている為、自由に変更して下さい。

対象月：2015/02
№ タスク Week1 Week2 Week3 Week4 Week5 Week6 Week7 Week8 Week9

Sprint1

1   スプリントバックログの抽出

2   機能設計

3   コーディング＆単体テスト

4   振り返り

5   納品

6   スプリントレビュー

Sprint2

7   スプリントバックログの抽出

8   機能設計

9   コーディング＆単体テスト

10   振り返り

11   納品

12   スプリントレビュー

Sprint3

13   スプリントバックログの抽出

14   機能設計

15   コーディング＆単体テスト

16   振り返り

17   納品

18   スプリントレビュー



理解度評価表 （スプリントｘ） 

実施日  ：   /   /   

記入者氏名：         

プロジェクト名  役割  

グループ  評価合計                ポイント 

 

１. 目的の理解度 …指定された役割で要求されている事は何でどのような結果を求められているか

について正確に把握できているか。 

評価 

 

 

２．作業の実行度  …指示された役割の目的達成に向けて正確に作業を実行できたか。 

評価 

 

 

３．問題解決力 …質問や発生した問題に対して、プロジェクトがより良い方向に向かう事を考慮して

判断し、的確に行動できたか。 

評価 

 

 

４．コミュニケーション力 …元請側の学生同士及び、オフショア側とのコミュニケーションが円滑に

正しく行われているか。 

評価 

 

 

５．ツール理解度 …Redmineの使い方を正確に理解し、効率よく使用できるか。 

 

評価 

 

コメント 

 

 

 

 

 

 高い  ・・・   低い 

 ５ ４ ３ ２ １ ０ 

高い  ・・・   低い 

 ５ ４ ３ ２ １ ０ 

高い  ・・・   低い 

 ５ ４ ３ ２ １ ０ 

高い  ・・・   低い 

 ５ ４ ３ ２ １ ０ 

高い  ・・・   低い 

 ５ ４ ３ ２ １ ０ 


